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Introduction

The Threatened Environment Classification has been developed by Landcare
Research — Manaaki Whenua to help identify areas in which much reduced and
poorly protected indigenous ecosystems are most likely to occur. The Threatened
Environment Classification can help in setting priorities for protection of indigenous
biodiversity, planning biodiversity protection activities, and/or reporting achievements.
It was developed with the help of end-users including regional councils, the
Department of Conservation, Ministry for the Environment, and QEII National Trust.

This document provides a step-by-step guide on how to upload the Threatened
Environment Classification table into a Geographical Information System (GIS)
program. A basic understanding of the program is necessary to subsequently create
maps.

In order to use the Threatened Environment Classification in a GIS, you will need to

1. Have access to a GIS program, such as ArcGIS, ArcView, Maplnfo.

2. Have access to the Land Environments of New Zealand data layers
(especially LENZ Level 4 Classification layer. When all data is installed from
the LENZ Classification CD, this raster layer “lenz_Ivl_4" will be in the folder
LENZ\Classification\LENZ_Class\

3. Download and save the Threatened Environment Classification table from the
web www.biocommunity.org.nz

o ltis available as an Excel file, which, in addition to the Threatened
Environment Classification table itself, has supplementary information
in the different worksheets. This file can also be used to import directly
into ArcGI1S9.2

o0 On the website, the Threatened Environment Classification table is
also available as a text file (.txt). It is recommended that you download
this table for use in ArcView or ArcGIS9.1 or earlier.

In the next section, the steps to upload the table and display the Threatened
Environment Classification on a Map in a GIS are set out in detail for the programs
ArcGIS 9.1 and 9.2 and ArcView 3.2. A similar section for Maplinfo is under
construction and will be posted on the website in due course.

For interpretation of the Threatened Environment Classification, please refer to the
“Guide for Users of the Threatened Environment Classification”, which can be found
on the website www.biocommunity.org.nz . Non-GIS users can download maps of
the Threatened Environment Classification for their region or district from this
website. Workshops will be held around the country in August 2007 to familiarise
users with the Threatened Environment Classification.
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ArcGIS 9.1 and 9.2

1.

ok

Download and save the Threatened Environment Classification table from the
website www.biocommunity.org.nz . Users of ArcGIS9.2 can save the Excel
file and directly import this into the programme. Users of ArcGIS9.1 or earlier
will need to have the table in text file format (*.txt or *.dbf). Either download
the Threatened Environment Classification table as a text file from the
website, or open the Excel Table in Excel, go File > Save as >, in the drop-
down box tick “Text (Tab delimited) (*.txt)” — or if that fails “DBF4 (dBASE IV)
(*.dbf)”, give it a name and click “Save”.

Open a new map in ArcMap

Click the “Add Data” button

Browse to the LENZ files, wherever they are stored on your computer. Add
the Level 4 classification, which is a raster dataset (e.g.
LENZ\Classification\LENZ_Class\lenz_Ivl_4).

Right click on the layer file in Table of Contents (left side of Map window)
Select “Joins and Relates” and “Join...”

- £ Layers

! X Remove
II Open Attribute Table

Joins and Relakes

Jain...
<& Zoom To Layer Remave Jains) »
@2 Zoom To Raster Resolution Relate...

Visible Scale Range » Remove Relate(s) B

Data »
Save As Layer File. ..

Properties. ..

Select “Join attributes from a table”

loin Data

Join lets you append additional data to this layer's attibute table o you can,
for example, symbalize the layer's features using this data

‘What do you want to join to this layer?

JJD\H attributes from 3 table L]

1. Choose the field in this layer that the join will be bagsed on.

[T |

Look in: ] ThreatCategories.xls j E] 5 || 55

Mame ‘ Type |

Categorydefinitions$ Excel Table
Kev§ Excel Table
LCDBClasses_Tnd$ Excel Tahle
LENZLwITVTable$ Excel Table

Mame: |LENZLNT ablet Add
Show of type: JTah\es and feature classes LJ Cancel
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7. Select the field that the join will be based on from the drop-down menu at 1. in
the Join Data Window (Select: LVL_4).

8. For ArcGIS9.2: Browse to the location of the downloaded Excel file with the
Classification (say, Threat_Classification.xlIs), and select the right worksheet
(LENZLvl4Table) (see image below). Click “Add”. Continue with step 10.

AginDate,

Join lets you append additional data to this layer's attibute table so you can,
for example, symbalize the layer's features using this data

‘What da you want to join ta this laper?

!Jom attributes from  table _:_]

1. Chaoose the field in this layer that the join will be based on:

[ =

2. Choose the table to join to this layer, or load the table from disk:

Loak in: I ThreatCategories.xls Ll | op|w|EE| EE) 1
Mame l Type 1
Categorydefinitions$ Excel Table
Kevd Excel Table
LCDEClasses_Ind$ Excel Table
LEMZLwIl¥Table$ Excel Table
Narme: |LEMZLANT able$ Add
Show of bpe: [T ables and feature classes - Cancel

9. For ArcGIS9.1 or earlier: Browse to the location of the downloaded text file
with the Classification (say, Threat_Classification.txt). Use this file as the
table to join to the LENZ layer by browsing to its location in the Join Data
Window. Click “Add”.

10. Select the field that the join will be based on from the drop-down menu at 3. in

Join Data lZ|

Join letz you append additional data to this layer's attribute table so you can,
for example, symbalize the layer's features using this data.

‘what do pou want to join to this laper?
IJoin attributes from a table ;I

1. Choose the figld in this layer that the join will be bazed on

JLoia ~|

2. Choose the table to join to this layer, or load the table from disk:

I lerz_threat_classification j Dml

v Show the attibute tables of layers in this list

3. Choose the field in the table to base the join on;

LWL 4 LI

Advanced... |

About Joining D ata | gk Cancel
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11.
12.

13.

~
.‘ . A &dd All Walues Add Yalues, .. f Default Colors |

the Join Data Window (LVL_4). The join is based on the name of the LENZ
Level 4 environments in the LENZ layer and in the Threatened Environment
Classification table.

Click “OK”

The Threatened Environment Classification table is now joined to the LENZ
Level 4 table! (You can view it by right clicking on the layer in the Table of
Contents, and click “Open Attribute Table”, scroll to the right of the table — you
will see that the columns from the Threatened Environment Classification
have been added and filled in for all the rows of the LENZ Level 4. The added
columns all start with the “LENZLvIIVTable$”, in addition to
“CATEGORY_NO”, “CRITERIA”, “THREAT_CATEGORY_NAME",

“% IND_COVER_REMAINING”, “%_protected”, “ind_cover_change_97-02").
You can now choose to display any of these added fields in your layer.
Double click the LENZ layer in the Table of Contents, go to the Symbology
Tab. Click “Categories — Unigue values” in the Show window, and select the
Threat Classification field in the Value Field drop-down menu
(LENZLVIIVTable$THREAT_CATEGORIES). Click “Apply” and “OK". The
map should now show the different Threat Classification categories. You can
also choose to display the criteria (e.g. <10% indigenous cover left) rather
than the category name (Acutely Threatened), or underlying data including %
indigenous remaining and % protected for each LENZ environment, by
choosing the appropriate Value Field from the drop-down menu.

" . - ——

General ] Source | Extent ] Dizplay  Symbalogy | Fields | Juins & Relates |
Show:
Draw raster assigning a color to each value Import...
Classified
Stretched Yalue Field Color Scheme .
Import Symbology
|LENZLIVTable}. THREAT_CATEGOI ~| | | |
Syrbol | <VALLE= | Label
<all other values> <all other values
<Heading > LENZL¥II¥Table
Acutely Threatened Acutely Threateng Eancal
Af Risk, Af Risk
| Chronically Threatened Chronically Threat
Critically Underprotected Critically Underprad
Less reduced and better protec Less reduced and betker protec?
Underprotected Underprotected 7

Display NoData as -

ak, | Cancel | Apply |

14.

15.

16.

ArcGIS will choose a colour scheme for the categories; however, we
encourage all users to use a standard colour scheme and symbology for the
creation of Threatened Environment Classification maps (see section on
Colour Schemes, page 9). Please download the layer file (.lyr) that has all this
information included from the www.biocommunity.org.nz . Save the layer file
in the same folder as your Threat Classification table.

In the Layer Properties, click “Unique Values” and “Import”. In the Import
Symbology Window navigate to where you saved the layer file.

Confirm the layer this symbology applies to is “lenz_Ivl_4". Click “Apply” and
“OK”. The map will now show the Threatened Environment Classification with
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the full criteria and colours ranging red—yellow—blue—green, using the colour
scheme as laid out in Table 1 (p. 9).

ArcView 3.2

1. Download the Threatened Environment Classification table (text file) from the
website www.biocommunity.org.nz

2. Open ArcView 3.2. You also need to activate the Spatial Analyst Extension in
order to view LENZ grids (Go File > Extensions and tick “Spatial Analyst”).

3. Open the View Window, and click the “Add Theme” button . Select “Grid
data source” as a file type option and browse to the LENZ files, wherever they

are stored on your computer. Add the classification for Level 4 (e.g.

LENZ\Classification\LENZ_Class\lenz_Ivl_4).

0 ArcView GIS 3.2

File Edit Table Field Window Help

()
0 of 501 selectsd
© viown MG
] Lenz_wi_a F
=51r: J'
10 802283 Fllal S0143 151 211 -
=:g; LR AR v T |7 23|
ol ne 6 Nl 15
BTTIRE e TiefL 12 26
BT TSSO Ta HEET e 111
PR P e e 72
8T Hide i a2 125
§ R R - I 126
10N P e T 116
T FRa el 4T 38
TR Fodal 112280 TEY e
e e e S j
=T

4. This theme’s Attribute Table will now open automatically (If it doesn't, click

&

5. In the project view, open the Tables Window, and click “Add” to add the
Threatened Environment Classification table (as *.txt or *.dbf). Browse to the

2 Arc¥iew GIS 3.2

File  Project  ‘window Help

20 Untitled

New |

| e |

" hdd Table

File Mame: Directories: oK.
[lenz_threat_classification. dof e\gisthemesilenz\threatenedeny
lenz_threat_classification. . = et - Cancel
[= gisthemes
= lenz
] info
£ keld_threat
List Files of Type: Drives:
[ dBASE [~.dbi) =] e B4
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location where you stored the table, and click “OK”. The table will be added to
the list, click on the name to open it.

6. Now both tables are open, and we can join the two, after highlighting the
fields on which the join is based (which will be the Lvl_4 column in both
tables).

7. Make the Threat Classification Table active, and click column “Lvl_4"

8. Make the LENZ Attribute Table active, and click column “Lvl_4"

attributes Of Le . MIRIEA || - tenz_threat_classification. dbf [_ O x]
Vataz Loy LI Heaotaned Flevadioe] Annas! tomd A i £ 0 cond £ gkl g cover | Theast ol Foie
1 802283:F1.1ai 50143 151 121 ;‘_ Al1a 83 66 No change No Threat | >20% p = |
J 131327 :C1.1ai 8208 172 12.2 A1.1b 52 47 | No change: No Threat | >20% p
4 3380448 : Null | 211278 292 105 = [Allc 17 7 | No changei Chronical | Criticall ~
B 18671 11.1a 1167 12 126 A21a 33 17 i Decrease | Underprot i Underp
3 1554968:01.1a 97186 216 11.1 A3la 91 100 No change: No Threat | >20% p
7 572170:P1.1a; 35761 1041 7.2 Ad1a 26 4 | Decrease | At Risk Criticall
8 176711 :H1.1a 11044 42 125 Ad.23 33 5 No change: Criticall Criticall
9 9001 i H3.1a 563 19 126 Ad.2b 5 7 No change! Acutely T | Criticall
10: 2036418 F1.2ai 127276 218 11.6 Ad4.2¢c 30 0 No change: At Risk Criticall
1 1251378 P5.1ai 78211 477 98 A5.1a 8 3| No change! Acutely T | Ciiticall
12 179670: F51ai 11229 54 125 = AB1b 5 1 Decrease : Acutely T Cliticallj
: L T T PR R T A ir..,._. ‘r-l A AR ry I T __’I_J.

9. Click the “Join” button . The table that is active when you choose “Join” is
the destination table (make sure this is the LENZ Attribute table), and the
information in the Threat Classification table will be added to this table (check
this and open the LENZ table, scroll to the right if necessary to see the added

columns of “category_no”, “criteria”, “threat_category _name”,
“%_ind_cover_remaining”, “%_protected”, “ind_cover_change_97-02").

10. You can now choose to show the Threat Classification (rather than LENZ
values) in the map in the View Window:

11. Double-click the “Lenz_Ivl4 Theme” in the Contents on the left-hand side of
the screen (or go Theme > Edit Legend)

12. For “Legend Type” select “Unique Value”

13. For “Values Field” select “Threat_category_name”

14. We encourage users to use common colours and symbology, please upload a
standard legend from www.biocommunity.org.nz Save the legend file (.avl
file) in the same folder as your Threat Classification table.

2 Legend Editor

Theme: [Lenz vl 4

Legend Type: [Unique Value =1 Save...

Default
Values Field: [Thieat_category_name =]
Symbol YValue Label Count
I | Acutely Thieatened | Acutely Threatened | 94252920 |

At Risk At Risk 44657894
Chranically Threatend Chronically Threatend 37131316

==l
=
|:] Ciitically Underprotec| Critically Underprotec| 28354826
|-
=

Less reduced and bel Less reduced and bel 1875550(

Underprotected Underprotected 24204425

— 3380448 v |
+|H| 57| o &4 3
Color Schemes: [ Bountiful Harvest == |
Advanced.. | Statistics.. | | tpoy |
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15. Choose “Load” in the Legend Editor Window, and browse to the location
where you saved the .avl file. Click “OK”.
16. In the next little window, choose “Threat_category _name” as the Field (tick

“All” if it's not already ticked). Click “OK”. Click “Apply”.

# Load Legend

File: 1 arne: Directaries: ok,
[ e hgisthemeshlenzhthreatenedeny
B threatenviegend avl - = et - Cancel
= gisthemes
= lenz
0 irfin
£ M4 threat
- -
List Files of Type: Dirives:
[Legend [=.avil =] e [

<! Load Legend @

Field: [ Thieat_category_name =]

v Al
[~ Classes
Sk

Cancel

17. The map will now show the Threatened Environment Classification with the
criteria as labels and colours ranging red—yellow—blue—green, using the
colour scheme as laid out in Table 1 below.

Page 8



Colour schemes

We would like to encourage users to apply a common symbology (as ArcGIS calls it!)
and colour scheme when producing maps, so that the results are easily exchanged
and information can be absorbed at a glance. Legend files (ArcView) and Layer files
(ArcGIS) can be downloaded to aid this process (www.biocommunity.org.nz). Table 1
includes the colours that are to be used for the different categories in different GIS
programmes. In ArcGIS the colours are all standard and can be chosen from the
colour panel; when you hover over the boxes the names will show up. Please note:
ArcView Hue/Saturation/Value values differ from standard HSVs, using the below
HSV values in a different programme will therefore produce quite different colours.

Table 1. Colour schemes for the Threatened Environment Classification

10-20% left

- 20-30% left

>30% left and
| <10% protected

>30% left ai

| 10-20%
! protected

i >30% left and

© >20% protected

Chronically

Threatened

| AtRisk

Critically
| Underprotected

nderprotected

Less Reduced and
Better Protected

Electron Gold

. Solar Yellow

S

. Olivine
Yellow

Category ' Category Category Name @ ArGIS 9.2 RGB ArcView
Criteria Colour 3.2 HSV
No Data White R:255 ' H:0
G:255 :S:0
B:255 V:0
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